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Accueil

(a) Tropy - Vue items en gallerie (b) Tropy - Vue items en liste (c) Tropy - Photo et sélections

Tropy1 est un logiciel libre (open source) conçu pour organiser et gérer des collections d’images.
Développé par la fondation Digital Scholar2 (qui développe aussi Zotero3 et Omeka4), il est
principalement utilisé dans le domaine de la recherche en sciences humaines et sociales (même
s’il est aussi apprécié par les usager·ère·s plus grand public des services d’archives comme
les généalogistes. (voir Valmalle, 2021)).

Il permet aux chercheur·es de classer, anoter, et organiser des photos et des documents
numérisés, comme des archives ou des manuscrits, en vue de faciliter leur utilisation et leur
éventuelle publication.

Principales fonctionalités :

• Création de projets pour organiser les images par collections et catégories (tags).
• Ajout de métadonnées détaillées à chaque objet (item), image et zone d’image (sélec-

tion).
• Possibilité d’associer des annotations aux images et aux sélections.
• Exportation des données sous forme de fichiers compatibles avec le web sémantique

(format JSON-LD par défaut) ou avec d’autres logiciels (comme Zotero ou OmekaS avec
les extensions5 dédiées).

1https://tropy.org
2https://digitalscholar.org/
3https://www.zotero.org/
4https://omeka.org/
5./tropy-extensions.qmd
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Pourquoi Tropy ?
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Tropy est un logiciel de bureau qui vous permet de stocker toutes vos photos localement et de
travailler hors-connexion internet.

Son point fort (outre ses interfaces de gestion et de visualistion de vos ressources photogra-
phiques) réside dans la gestion de métadonnées riches et interopérables.

Tropy n’est pas :

• Un logiciel d’édition de photos comme Photoshop
• Un logiciel de gestion de références bibliographiques comme Zotero
• Une plateforme d’écriture
• Une plateforme pour présenter vos ressources en ligne comme Omeka
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Des métadonnées riches…

Dans la documentation de Tropy : What is metadata and how do I use it?1

Que sont les métadonnées ?

Les métadonnées sont des données qui décrivent d’autres données. Elles fournissent
des informations sur un fichier, un document, ou tout autre type de ressource numérique. Par
exemple, pour une photo, les métadonnées peuvent inclure le titre, le nom du créateur, la
date de création, le format, et les droits d’utilisation.

Les métadonnées aident à organiser, identifier et trouver facilement des informations en
donnant des détails sur le contenu, la structure et le contexte des données (ici vos objets,
images et sélections).

Qu’est-ce qu’un schémas de métadonnées ?

Un schéma de métadonnées est un ensemble structuré de règles et de propriétés
utilisées pour décrire de manière cohérente des données ou des ressources. Il définit quelles
informations (ou métadonnées) doivent être collectées, comme le titre, le créateur, la date,
ou le type de ressource, ainsi que la manière de les organiser.

Un schéma de métadonnées est une structure standardisée qui aide à organiser et harmo-
niser les informations descriptives sur des fichiers ou documents, facilitant ainsi leur recherche
et leur gestion.

Dans Tropy, des schémas de métadonnées comme les Dublin Core, Exif, ou Europeana
Data Model (EDM) sont chargés par défaut. En fonction des besoins de votre projet et
du type d’objets que vous décrivez, vous avez également la possibilité de personnaliser ou
importer vos propres schémas selon des standards adaptés à vos recherches (comme CIDOC-
CRM2, VRA Core3…).

1https://docs.tropy.org/before-you-begin/metadata
2https://www.cidoc-crm.org
3https://www.vraweb.org/vra-core-data-standard
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Les schémas Dublin Core

Il existe deux schémas de métadonnées dits Dublin Core, tous deux disponibles par défaut
dans Tropy : le Dublin Core Metadata Element Set4 et les Dublin Core Metadata Terms5.

La différence entre les Dublin Core Elements et les Dublin Core Terms réside principa-
lement dans leur étendue, leur structure, et leur niveau de formalisation.

Dublin Core Elements

Le Dublin Core Metadata Element Set (DCES6) est un ensemble de 15 éléments de
métadonnées de base, conçus pour être utilisés de manière générale pour décrire une large
gamme de ressources numériques. Ces éléments sont simples et universels, ce qui les rend
largement utilisables dans différents contextes.

Les 15 éléments Dublin Core Elements

1. Title (Titre)
2. Creator (Créateur)
3. Subject (Sujet)
4. Description
5. Publisher (Éditeur)
6. Contributor (Contributeur)
7. Date
8. Type
9. Format

10. Identifier (Identifiant)

4https://www.dublincore.org/specifications/dublin-core/dces/
5https://www.dublincore.org/specifications/dublin-core/dcmi-terms/
6https://www.dublincore.org/specifications/dublin-core/dces/
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11. Source
12. Language (Langue)
13. Relation (Relation avec d’autres ressources)
14. Coverage (Couverture géographique ou temporelle)
15. Rights (Droits)

Usage

Ces éléments sont conçus pour être simples et suffisamment génériques pour s’adapter à divers
environnements de gestion de métadonnées, notamment les bibliothèques, les archives, et les
musées. Ils ne nécessitent pas une grande complexité ou personnalisation, et peuvent être
utilisés dans de nombreuses disciplines.

Objectif

Faciliter l’interopérabilité entre différents systèmes et rendre les ressources numériques faci-
lement trouvables et accessibles. C’est l’ensemble de métadonnées de base recommandé pour
les projets qui veulent une approche standard, mais simple.

Formalisation

Les Dublin Core Elements7 font partie des normes ISO et sont compatibles avec les pratiques
d’interopérabilité sémantique sur le web.

Dublin Core Terms

Les Dublin Core Metadata Terms (DCTerms8) est une extension du Dublin Core Ele-
ments. Il comprend non seulement les 15 éléments de base, mais aussi un ensemble beaucoup
plus vaste de termes supplémentaires, incluant des sous-éléments, des éléments de qua-
lification (qualifiers), et des concepts plus précis qui permettent d’enrichir la description
des ressources.

7https://www.dublincore.org/specifications/dublin-core/dces/
8https://www.dublincore.org/specifications/dublin-core/dcmi-terms/
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Structure étendue des DCMT

Les Dublin Core Terms incluent :

• Les 15 éléments de base (mais sous des formes plus formalisées).
• Des éléments supplémentaires comme Audience (Public), Provenance (Pro-

venance), Accrual Method (Méthode d’acquisition), etc.
• Des qualificateurs qui permettent de préciser davantage un élément existant. Par

exemple, la date peut être qualifiée avec des sous-éléments comme Date.Created
(date de création), Date.Modified (date de modification).

Usage

Les Dublin Core Terms9 sont utilisés dans des contextes plus complexes ou spécialisés où il est
nécessaire d’étendre la description des métadonnées au-delà des 15 éléments de base. Cela
permet d’adapter les métadonnées à des besoins spécifiques, comme dans les bibliothèques
numériques avancées, les archives, ou des bases de données nécessitant une structure riche.

Objectif

Fournir une structure plus flexible et plus riche pour décrire des ressources en utilisant
des éléments plus détaillés. Il permet de mieux correspondre aux besoins spécifiques des projets
tout en restant compatible avec les standards du web sémantique.

Formalisation

Les Dublin Core Terms10 sont également formalisés selon des standards internationaux et sont
souvent exprimés en RDF (Resource Description Framework) pour une meilleure compatibilité
avec le web sémantique.

Principales différences entre Dublin Core Elements et Dublin Core Terms

9https://www.dublincore.org/specifications/dublin-core/dcmi-terms/
10https://www.dublincore.org/specifications/dublin-core/dcmi-terms/
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Table 1: Comparaison DCES11 et DCTerms12

Critères
Dublin Core Elements
(DCES13)

Dublin Core Terms
(DCTerms14)

Nombre d’éléments 15 éléments de base Comprend les 15 éléments +
des termes étendus et
qualificateurs

Simplicité Simple, général Plus complexe, flexible et
spécifique

Utilisation Projets de description de
ressources de base

Projets nécessitant des
métadonnées plus riches et
complexes

Interopérabilité Conçu pour des utilisations
larges et génériques

Plus détaillé, mais
compatible avec des
systèmes plus complexes

Qualification des
éléments

Pas de qualificateurs Supporte des qualificateurs
pour une meilleure précision

Exemples d’utilisation Bibliothèques, archives
numériques simples

Bibliothèques numériques
avancées, projets
sémantiques, bases de
données spécialisées

Synthèse Dublin Core

• Dublin Core Elements est idéal pour une description simple et universelle
de ressources numériques, facilitant une adoption rapide et large dans des environ-
nements variés.

• Dublin Core Terms fournit un cadre plus élaboré, utile pour des projets né-
cessitant une description plus fine et spécialisée, avec une interopérabilité accrue
dans des environnements complexes comme le web sémantique.

11https://www.dublincore.org/specifications/dublin-core/dces/
12https://www.dublincore.org/specifications/dublin-core/dcmi-terms/
13https://www.dublincore.org/specifications/dublin-core/dces/
14https://www.dublincore.org/specifications/dublin-core/dcmi-terms/
15https://www.dublincore.org/specifications/dublin-core/dces/
16https://www.dublincore.org/specifications/dublin-core/dcmi-terms/
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Le schéma Europeana Data Model (EDM)

Europeana Data Model est un schéma utilisé par Europeana17 18 pour décrire des objets
culturels numériques en accord avec les standards du web sémantique.

Caractéristiques clés :

• Modèle RDF : EDM est basé sur le Resource Description Framework (RDF21), un
standard du W3C22 utilisé pour représenter des informations sur des ressources dans le
web sémantique. Cela permet de relier des objets à d’autres ressources, qu’elles soient
internes ou externes à Europeana.

• Séparation des différentes entités : EDM distingue clairement plusieurs types
d’entités, ce qui permet de modéliser les relations complexes entre les objets numériques
et leur contexte. Parmi ces entités, on trouve :

– ProvidedCHO (Cultural Heritage Object) : représente l’objet culturel lui-même (par
exemple, une peinture, un manuscrit).

– WebResource : fait référence aux versions numériques de l’objet, telles que les fichiers
d’image, vidéo ou son.

– Aggregation : permet de regrouper les données sur un objet, notamment les méta-
données des différentes sources.

– Agent : représente les entités ayant une influence sur l’objet (par exemple, un auteur,
un artiste, un contributeur).

– Place et TimeSpan : permettent de contextualiser l’objet dans le temps et l’espace.

• Multi-représentation : EDM permet d’avoir plusieurs représentations numériques d’un
même objet culturel (images de différents angles, fichiers audio associés, etc.), ainsi que
des relations entre ces différentes représentations.

• Alignement avec d’autres standards : EDM est conçu pour être interopérable avec
d’autres schémas de métadonnées, notamment Dublin Core, LIDO (utilisé dans les
musées), EAD (Description archivistique encodée), et OAI-PMH (Open Archives Ini-
tiative Protocol for Metadata Harvesting).

17https://www.europeana.eu/fr
18Europeana19 est un portail européen qui présente des ressources patrimoniales provenant de quelque 2000

institutions différentes. Un réseau de partenaires agrégateurs se charge de collecter les données, de les vérifier
minutieusement et de les enrichir d’informations telles que la géolocalisation, ou de les relier à d’autres
données ou ensembles de données par le biais de personnes, de lieux ou de thèmes associés. (Liste des
partenaires agrégateurs20, dont Gallica)

21https://www.w3.org/TR/rdf11-primer/
22https://www.w3.org
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Les proriétés Exchangeable Image File Format (EXIF)

EXIF est un ensemble de propriétés techniques centré sur les conditions de création des
fichiers visuels. Contrairement au Dublin Core, il ne vise pas à fournir une description séman-
tique mais plutôt une description technique du fichier lui-même.

EXIF est un standard de métadonnées techniques utilisé principalement dans les fichiers
d’image (JPEG, TIFF) et les fichiers vidéo pour enregistrer des informations relatives aux
conditions dans lesquelles l’image ou la vidéo a été capturée. Cela inclut des données tech-
niques comme les paramètres de l’appareil photo (modèle, vitesse d’obturation, ouverture,
ISO, orientation), la date et l’heure, des informations géographiques (si le GPS est activé)
ainsi que des informations sur le fichier (taille, résolution).

La page Wikipedia Exchangeable image file format23 donne un exemple24 concret et la liste
des principales métadonnées EXIF25.

Ces propriétés sont enregistrées dans le fichier numérique lui-même. Dans Tropy, on ajoutera
des propriétés EXIF dans des modèles de niveau photo, pour “sortir” automatiquement ces
informations du fichier.

Tropy extrait automatiquement les données suivantes pour chaque photo :

• Le nom du fichier

• La date de création

• la taille de l’image en pixels (800X1200)

• la taille de l’image en octets (bytes)

23https://fr.wikipedia.org/wiki/Exchangeable_image_file_format
24https://fr.wikipedia.org/wiki/Exchangeable_image_file_format#Exemple
25https://fr.wikipedia.org/wiki/Exchangeable_image_file_format#Liste_des_principales_m%C3%A9tado

nn%C3%A9es_EXIF
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Pour réutiliser ou partager son corpus

Si vous citez vos photos dans un document de recherche, vous pouvez avoir envie de les dé-
poser dans un entrepôt de données (pour les partager, les réutiliser plus tard ou les archiver).
Il convient alors d’adapter son modèle de saisie dans Tropy aux propriétés demandées ou
disponibles dans l’entrepôt visé.

Exemple de Nakala

Nakala1 est l’entrepôt de données de HumaNum2. Vos photos de recherche peuvent être consi-
dérées comme des données de recherche (surtout si vous les utilisez dans vos publications).

Huma-Num, dans la riche documentation de Nakala, a publié un Guide pour décrire ses données
dans Nakala3 (Huma-Num, 2024).

Huma-Num a aussi publié une fiche pdf4 imprimable d’aide au dépôt dans Nakala (mars
2024).

1https://nakala.fr
2https://www.huma-num.fr
3https://documentation.huma-num.fr/nakala-guide-de-description/
4https://documentation.huma-num.fr/media/nakala/Guide_depot_Nakala_mars-2024.pdf
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Ce guide est mis à disposition des personnes qui déposent ou accompagnent au dépôt des données 
dans l’entrepôt NAKALA.

NAKALA est un entrepôt de données de recherche pour les sciences humaines et sociales. Son accès 
et son utilisation sont décrits dans la documentation d’Huma-Num :
https://documentation.huma-num.fr/nakala/

La qualité et la richesse de la description des données sont des critères centraux des principes FAIR. 
Cela constitue un moyen d’atteindre les objectifs visés (faire en sorte que les données soient faciles à 
trouver, accessibles, interopérables et réutilisables).

La qualité se met en œuvre, par exemple:

• en utilisant des référentiels standardisés;

• en respectant les mêmes normes intellectuelles de description pour un ensemble de données;

• en choisissant des champs de métadonnées les plus adaptés à l’information donnée.

La richesse se met en œuvre en complétant le plus grand nombre possible de champs afin d’optimiser 
la compréhension des données. Dans NAKALA, la description est basée sur un ensemble minimal de 
cinq informations qui peuvent être enrichies de manière étendue et cumulative. 

Ce guide propose un ensemble de conseils et bonnes pratiques pour les fichiers et les champs de 
métadonnées obligatoires et complémentaires de premier niveau.

Pour aller plus loin, un guide de description est disponible : 
https://documentation.huma-num.fr/nakala-guide-de-description/

Contact: nakala@huma-num.fr

SUIVI
Nom du déposant: 
Titre de la donnée: 
DOI: 
Suivi accompagné par: 
Date du suivi : 

Guide de dépôt

Critères Commentaires et propositions 
d’amélioration

Nommage

Il est recommandé d’établir un plan de nommage (préfixe commun pour tous les fichiers 
associés au projet) afin que les noms des fichiers soient cohérents et réguliers.
Remarque : pour un dépôt multifichiers, NAKALA permet de trier les fichiers par ordre alphabétique, 
après chargement.

Description

La description des fichiers peut être saisie: 
• pour des informations spécifiques à un fichier, dans le champ «Description» associé à chaque 

fichier.
Ces informations sont indexées par NAKALA et sont affichées dans la visionneuse.

• pour des informations globales sur l’organisation interne, le contenu, la définition des variables 
du ou des fichiers de la donnée, dans un document à part (type README, manifest IIIF, TEI-
header, métadonnées métier, METS, etc.).

Formats

NAKALA accepte tous les formats, mais quand c’est possible, privilégier un format ouvert 
compatible avec FACILE, le service de validation des formats: https://facile.cines.fr/

Pour les fichiers au format texte, l’encodage de caractères en UTF-8 est recommandé, si 
applicable.

La liste des formats supportés par l’API IMAGE IIIF dans NAKALA : « tif », «tiff», « jpg », « jpeg», 
« jp2», «png», «pdf», «geojp2».
Ces formats sont recommandés pour bénéficier des fonctionnalités du protocole IIIF.

Les fichiers

Mars 2024
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Prise en main
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Créer un projet

Figure 1: Menu: Fichier > Nouveau > Projet (Ctrl+Maj+P)

• Lui donner un nom

• Choisir le type (voir Lucchesi et al., 2023).

– Standard : Copie les photos dans le dossier du projet à l’import
– Advanced : Lien vers les photos sur votre disque (/!\)

• Choisir l’emplacement du projet sur son ordinateur
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Suggestion

Dans le dossier Images par défaut, un sous-dossier Tropy, puis un sous-dossier par
projet.
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Les modèles de saisie

Figure 1: Préférences de Tropy > Modèles de saisie

Trois types d’objets dans Tropy

Donc trois types de modèles :

• Objet (Item) contient une ou plusieurs Photos
• Photo Contient zero, une ou plusieurs Sélections
• Sélection

21



Dans la documentation officielle

• Getting started with templates1

Les modèles inclus dans Tropy

• Niveau item : Tropy Generic, Tropy Correspondance et Dublin Core
• Niveau photo : Tropy Photo
• Niveau selection : Tropy Selection

Ces modèles ne peuvent être supprimés ni effacés.

Créer ou personnaliser un modèle de saisie

Créer un modèle

Dans la fenêtre des préférence, onglets des modèles de saisie :

• Vider le champ Modèle de saisie
• Entrer un Nom (au choix)
• Choisir le Type (Objet, Photo ou Sélection)
• Renseigner le Créateur (Vous)
• Ajouter une petite Description
• Cliquer sur Créer

1https://docs.tropy.org/in-the-template-editor/using-templates
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Figure 2: Nouveau modèle

Ajouter des propriétés

Figure 3: Propriété

Personnaliser un modèle

• Cliquer sur l’icône Dupliquer
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Figure 4: Dupliquer

• Ajouter, supprimer, déplacer, modifier les propriétés

Exemple du Projet Blot

• Template BlotPhotosV2.ttp : Télécharger2

• Description dans le wiki du projet3

2BlotPhotosV2.ttp
3https://git.univ-pau.fr/gaelannuzelt/projet-blot/-/wikis/Templates-Tropy
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Les extensions (Plugins)

Figure 1: Menu: Préférences… - Plugins

Table 1: Table des extensions

Nom (et lien) Description
tropy-plugin-csl1 Tropy plugin to export your items to Zotero as CSL/JSON
tropy-plugin-omeka2 This plugin can export selected items into an Omeka S3

instance.
tropy-plugin-archive4 Tropy plugin for exporting items into a single zip archive. This

includes all the metadata, as well as the photo files.

1https://github.com/tropy/tropy-plugin-csl
2https://github.com/tropy/tropy-plugin-omeka
3https://omeka.org/s/
4https://github.com/tropy/tropy-plugin-archive
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Nom (et lien) Description
tropy-plugin-csv5 Tropy plugin to import items from a CSV file, and export your

items to CSV.
tropy-plugin-iiif6 Download a IIIF manifest and select File > Import >

tropy-plugin-iiif to start the import. The plugin tries to map
the manifest’s metadata to standard metadata properties.

5https://github.com/tropy/tropy-plugin-csv
6https://github.com/tropy/tropy-plugin-iiif
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Importer des photos

Formats supportés

• JPG/JPEG
• PNG
• SVG
• TIFF
• GIF
• PDF
• JP2000
• WEBP
• HEIC
• AVIF

Attention

• Projet Standard

– Copie des fichiers dans le dossier du Projet
– Risque de doublon sur le disque dur (place)

• Projet Advanced

– Simple création d’une miniature et lien vers l’emplacement du fichier sur votre
disque

– Risque de perte de données dans le projet si vous déplacez ou supprimez vos
fichiers

Par le Menu Fichier

... > Fichier > Importer > Photos | Dossier

• Penser à définir le bon modèle d’import par défaut avant.
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Figure 1: Préférences de Tropy > Paramètres

Par glisser-déposer

• De la fenêtre du dossier d’origine vers la fenêtre de Tropy (vue projet)

• Même recommandation (modèle d’import).

Par surveillance d’un dossier

• Menu édition:

... > Édition > Préférences...

Onglet Projet -> Watch folder…

Par des plugins/extensions

CSV

1. Installer le plugin CSV1

2. Menu: Edition > Préférences… | onglet Plugins -> Définir un profil d’import CSV
3. Menu: Fichier > Importer > Profil CSV : chemin du fichier .csv

IIIF

1. Installer le plugin IIIF2

1https://github.com/tropy/tropy-plugin-csv
2https://github.com/tropy/tropy-plugin-iiif
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2. Menu: Edition > Préférences… | onglet Plugins -> Définir un profil d’import (modèle de
saisie) IIIF dans les paramètres du plugin.

3. Télécharger un manifeste IIIF (souvent un fichier manifest.json) sur son ordinateur
depuis un catalogue IIIF (Gallica, Biblissima, Europeana..)

• Liste de collections utilisant IIIF pour partager leurs ressources3 (IIIF Consortium,
2024)

4. Dans Tropy, Menu: Fichier > Importer > Profil IIIF : chemin du fichier manifest.json

3https://iiif.io/guides/finding_resources/
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Exporter (projet, photos, données)

Préférences > Export

Menu Exporter

• JSON-LD : LD pour Linked Data
• PDF
• Plugins

Plugins

• Archive : Photos et métadonnées dans un .zip
• CSV
• Omeka S
• CSL (Zotero)

Imprimer
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Ressources sur Tropy
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Canaux officiels

• Documentation1

• Support2 (forum)
• Vimeo3

• Youtube4

• X/Twitter5

• GitHub6 (code source, templates…)

1https://docs.tropy.org/
2https://forums.tropy.org/
3https://vimeo.com/user73164761
4https://www.youtube.com/@tropy
5https://twitter.com/tropy
6https://github.com/tropy
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Tutoriels

Table 1: Table des Tutoriels Tropy

Auteur lien
Benjamin Lailler Tutoriel Tropy1 (Laillier, 2019)
Stretching numérique 2024 Gérer ses photos d’archives avec Tropy2

(Leromain, 2024)
Schlesinger Library on the History of Women
in America - Harvard University

Manage Research Images With Tropy3

(Fauxsmith, 2019)
BULAC Gérer ses ressources iconographiques avec

Tropy4 (Maisonneuve, 2024)
Rennes 2 Gérer ses photos de recherche avec Tropy5

(Croizet, 2024)

1https://zenodo.org/records/3381981
2https://zenodo.org/records/10939791
3https://guides.library.harvard.edu/c.php?g=833532&p=5990005
4https://www.bulac.fr/document/gerer-ses-ressources-iconographiques-avec-tropy-mai-2024
5https://tutos.bu.univ-rennes2.fr/c.php?g=702342
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Vidéos

• Le 16 juin 2020, L’équipe de Tropy (Abby Mullen) a tenu un webinaire de type Tropy
101 [Youtube - 1h051]

https://www.youtube.com/embed/jWjP90EWHkQ

• Tropy chanel : Metadata Templates in Tropy [Youtube - 10 mn2]

https://www.youtube.com/embed/Hk5APGD6200

• Projet EVEille3 : Séance d’initiation à Tropy, animée par Benoît Roux, juin 2021 [e-
diffusion UHA - 1h284]

https://e-diffusion.uha.fr/video/4023-initiation-a-tropy-avril-2021

• (Valmalle, 2021) Geneatech : Utiliser Tropy pour la gestion de ses photos d’archive [You-
tube - 17 mn5]

https://www.youtube.com/embed/AiPqbdwP67E

1https://www.youtube.com/watch?v=Hk5APGD6200
2https://www.youtube.com/watch?v=Hk5APGD6200
3https://eveille.hypotheses.org/
4https://e-diffusion.uha.fr/video/4023-initiation-a-tropy-avril-2021/
5https://www.youtube.com/watch?v=AiPqbdwP67E
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Billets de blog

• Gérer ses photos d’archives avec Tropy1 - Franziska Heimburger - La boîte à outils des
historien·ne·s (Heimburger, 2017)

• Tropy, un gestionnaire de photos d’archives pour les chercheurs2 - Florian Innocente,
MacGeneration (Innocente, 2017)

• Six months of using Tropy3 - Emmanuel Mourlon-Druol (Mourlon-Druol, 2019)
• Tropy : un logiciel pour organiser des corpus iconographiques4 - Le Carreau de la BULAC

(Larguèche, 2021)
• Personal image management software rec from an art historian: Tropy5 - Elizabeth Lee

- The Digital Orientalist (Lee, 2021-03-16T)
• New Project Types in Tropy 1.136 - Tropy Blog (Lucchesi et al., 2023)

1http://www.boiteaoutils.info/2017/10/gerer-ses-photos-darchives-avec-tropy/
2https://www.macg.co/logiciels/2017/10/tropy-un-gestionnaire-de-photos-darchives-pour-les-chercheurs-

100197
3https://www.e-mourlon-druol.com/six-months-of-using-tropy/
4https://bulac.hypotheses.org/33406
5https://digitalorientalist.com/2021/03/16/personal-image-management-software-rec-from-an-art-historian-

tropy/
6https://tropy.org/blog/new-project-types-in-tropy-1-13
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Produire des données FAIR

• Inspirés par le 5-Star Open Data proné par Tim-Berners Lee, mis en forme par Michael
Hausenblas sur ce site : http://5stardata.info/fr/ [22 janvier 2012].

Les étapes 5-Star OpenData

Table 1: Illustration des étapes 5-Star OpenData

étoiles étape
� Publiez vos données sur le Web (peu importe leur format) avec une

licence ouverte
�� Publiez-les en tant que données structurées (par exemple, un

document Excel au lieu d’une image scannée d’un tableau)
��� Publiez-les dans un format ouvert et non-propriétaire (par exemple,

un CSV plutôt qu’un Excel)
���� Utilisez des URI pour désigner des choses dans vos données, afin que

les gens puissent faire des références à celles-ci
����� liez vos données à d’autres données pour y ajouter du contexte

• Décrits ici1, d’aprèsThe FAIR Guiding Principles for Scientific Data Management and
Stewardship. DOI2

The principles refer to three types of entities: data (or any digital object), metadata
(information about that digital object), and infrastructure. For instance, principle
F43 defines that both metadata and data are registered or indexed in a searchable
resource (the infrastructure component).

1https://www.go-fair.org/fair-principles/
2https://doi.org/10.1038/sdata.2016.18
3https://www.go-fair.org/fair-principles/f4-metadata-registered-indexed-searchable-resource/
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Findable

The first step in (re)using data is to find them. Metadata and data should be easy to find for
both humans and computers. Machine-readable metadata are essential for automatic discovery
of datasets and services, so this is an essential component of the FAIRification process4.

• F1. (Meta)data are assigned a globally unique and persistent identifier5

• F2. Data are described with rich metadata (defined by R1 below)6

• F3. Metadata clearly and explicitly include the identifier of the data they describe7

• F4. (Meta)data are registered or indexed in a searchable resource8

Accessible

Once the user finds the required data, she/he/they need to know how can they be accessed,
possibly including authentication and authorisation.

• A1. (Meta)data are retrievable by their identifier using a standardised communications
protocol9

– A1.1 The protocol is open, free, and universally implementable10

– A1.2 The protocol allows for an authentication and authorisation procedure, where
necessary11

• A2. Metadata are accessible, even when the data are no longer available12

Interoperable

The data usually need to be integrated with other data. In addition, the data need to interoperate
with applications or workflows for analysis, storage, and processing.

4https://www.go-fair.org/fair-principles/fairification-process/
5https://www.go-fair.org/fair-principles/fair-data-principles-explained/f1-meta-data-assigned-globally-

unique-persistent-identifiers/
6https://www.go-fair.org/fair-principles/fair-data-principles-explained/f2-data-described-rich-metadata/
7https://www.go-fair.org/fair-principles/f3-metadata-clearly-explicitly-include-identifier-data-describe/
8https://www.go-fair.org/fair-principles/f4-metadata-registered-indexed-searchable-resource/
9https://www.go-fair.org/fair-principles/542-2/

10https://www.go-fair.org/fair-principles/a1-1-protocol-open-free-universally-implementable/
11https://www.go-fair.org/fair-principles/a1-2-protocol-allows-authentication-authorisation-required/
12https://www.go-fair.org/fair-principles/a2-metadata-accessible-even-data-no-longer-available/
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• I1. (Meta)data use a formal, accessible, shared, and broadly applicable language for
knowledge representation.13

• I2. (Meta)data use vocabularies that follow FAIR principles14

• I3. (Meta)data include qualified references to other (meta)data15

Reusable

The ultimate goal of FAIR is to optimise the reuse of data. To achieve this, metadata and data
should be well-described so that they can be replicated and/or combined in different settings.

• R1. (Meta)data are richly described with a plurality of accurate and relevant attributes16

– R1.1. (Meta)data are released with a clear and accessible data usage license17

– R1.2. (Meta)data are associated with detailed provenance18

– R1.3. (Meta)data meet domain-relevant community standards19

13https://www.go-fair.org/fair-principles/i1-metadata-use-formal-accessible-shared-broadly-applicable-
language-knowledge-representation/

14https://www.go-fair.org/fair-principles/i2-metadata-use-vocabularies-follow-fair-principles/
15https://www.go-fair.org/fair-principles/i3-metadata-include-qualified-references-metadata/
16https://www.go-fair.org/fair-principles/r1-metadata-richly-described-plurality-accurate-relevant-

attributes/
17https://www.go-fair.org/fair-principles/r1-1-metadata-released-clear-accessible-data-usage-license/
18https://www.go-fair.org/fair-principles/r1-2-metadata-associated-detailed-provenance/
19https://www.go-fair.org/fair-principles/r1-3-metadata-meet-domain-relevant-community-standards/
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Autour des standards IIIF

IIIF (International Image Interoperability Framework™) est un ensemble de standards
qui définissent un cadre d’interopérabilité pour la diffusion des images numériques sur le
Web.

IIIF permet la manipulation homogène d’images indépendamment de leurs localisations phy-
siques et des établissements qui les hébergent. (utilisé notamment sur Europeana1 , Gallica3,
Nakala, de nombreux serveurs Omeka…)

• Une excellente documentation5 chez Biblissima.

• Une très large collection de ressources sur le GitHub du consortium : Awesome Interna-
tional Image Interoperability Framework (IIIF)6

• La visionneuse Mirador7

Importer dans Tropy des documents Gallica via le module IIIF

• API IIIF de récupération des images de Gallica :

– Base URL : gallica.bnf.fr/

– Manifest : iiif/{ark}/manifest.json

– Modèle : gallica.bnf.fr/iiif/ark:/XXXXX/manifest.json

– Exemples :

∗ gallica.bnf.fr/iiif/ark:/12148/bd6t538312611/manifest.json
∗ gallica.bnf.fr/iiif/ark:/12148/btv1b8451475v/manifest.json

1Europeana IIIF APIs2

3API IIIF de récupération des images de Gallica4

5https://iiif.biblissima.fr
6https://github.com/IIIF/awesome-iiif
7https://projectmirador.org
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Bonus

• Publier une image avec ses annotations : utilisation de Tesselle en histoire de l’art8 -
Antoine Courtin (Numérique et recherche en histoire de l’art, 2020).

– Tesselle9 - médialab SciencesPo

• Avec des sources iiif : Adno10

– Exemples11

– Documentation12

8https://numrha.hypotheses.org/1019
9https://medialab.github.io/tesselle/#/

10https://adno.app/fr/
11https://adno.app/fr/example/
12https://adno.app/fr/docs/prologue/quick-start/
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